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Micro Focus COBOL Server 2.3 Release
Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

COBOL Server provides the execution environment for applications created with any IDE variant of Visual
COBOL.

• This document contains a number of links to external Web sites. Micro Focus cannot be responsible for
the contents of the Web site or for the contents of any site to which it might link. Web sites by their
nature can change very rapidly and although we try to keep our links up-to-date, we cannot guarantee
that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

• This product includes OpenSSL version 1.0.1m.
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Installation

Installing on Windows

System Requirements for COBOL Server for Windows

Hardware Requirements
The disk space requirements are approximately:

COBOL Server Sentinel RMS License Manager

525MB 75MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in COBOL Server.
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To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 6
• Application server JCA support for Enterprise Server
• Consolidated Trace Facility on page 7
• Database Access on page 7
• XML Extensions on page 7

Application server support for JVM COBOL

Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.7 Servlets 2.5

JBoss 7.1.1 1.7 Servlets 2.5

WebLogic 12.1.1 1.7 Servlets 2.5

WebSphere 8.5 1.7 Servlets 2.5
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You need Oracle's JDK. The earliest supported release of Oracle's JDK 1.7 is 1.7.027. You can download
Oracle's JDK from Oracle's Web site.

Application server JCA support for Enterprise Server

Back to Top

Restriction: This feature applies only when the Enterprise Server feature is enabled.

Java EE 5 and Java EE 6 are supported for the deployment of EJBs generated using the Interface Mapping
Toolkit, as follows:

• Java EE 5 includes support for EJB 3.0 and Java Connector Architecture 1.5
• Java EE 6 includes support for EJB 3.1 and Java Connector Architecture 1.6

The following Java application servers are supported using the following JDKs:

Application Servers JDK (vendor) Java EE COBOL RA

JBoss 5.1.0 1.6 (Oracle) 5 X

JBoss 6.1.0 1.6 (Oracle) 6 X

JBoss 7.1.1 1.7 (Oracle) 6 X

Oracle WebLogic 10.3.5 1.6 (Oracle) 5 X

Oracle WebLogic 12.1.1 1.6/1.7 (Oracle) 6 X

IBM WebSphere 7.0 1.5 (IBM) 5 X

IBM WebSphere 8.0 1.6 (IBM) 6 X

IBM WebSphere 8.5 1.6/1.7 (IBM) 6 X

Back to Top

Consolidated Trace Facility

• The Microsoft .NET Framework 2.0 or later is required for the CTF Viewer. It is available from the
Microsoft .NET downloads area.

Database Access

Back to Top

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the product help for Enterprise Developer, Welcome > Product Information > Installing >
System Requirements > Additional Software Requirements > Database Access, for details.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:
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• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing COBOL Server for Windows

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.

• This release will not upgrade previous versions of the product. Any previous releases and HotFixes of
the product installed on your machine must be uninstalled before installing 2.3.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
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restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Installing
Note: See Installing as an Upgrade first for important information, if you have an earlier version of
COBOL Server installed on your machine.

These are the steps to install this product:

1. Run the cs_23.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in the topic Software
Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

COBOL Server Installation Options
To install COBOL Server you run cs_23.exe which contains a number of product .msi files (Windows
Installer packages). When run, cs_23.exe performs some initial system checks then sequentially installs
the .msi files.

cs_23.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
cs_23.exe

Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
cs_23.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
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cs_23.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
cs_23.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: cs_23.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
To access the COBOL Server help:

• On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus COBOL Server >
Documentation from the Windows Taskbar.

• On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the COBOL Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Micro Focus
Developer > Micro Focus COBOL Server.

Note:

For applications created with earlier Micro Focus products or earlier versions of Visual COBOL, note
the following:

Database Access Managed applications using SQL(DBMAN=ODBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.3.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Visual COBOL.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.
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Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

Installing on UNIX

System Requirements for COBOL Server for UNIX

Hardware Requirements for COBOL Server
The disk space requirements are approximately:

Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER
running AIX

Micro Focus installer 353 1.41 GB 706 36.5

HP IA Micro Focus installer 685 2.74 GB 1370 69

System Z
running Red Hat
Linux

Micro Focus installer 284 1.14 GB 568 36

x86-64 running
Red Hat Linux

Micro Focus installer 298 1.19 GB 596 46

SPARC running
Solaris

Micro Focus installer 342 1.37 GB 684 40
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Platform Installer type Setup

file size

(MB)

Disk space

required for

the installation

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

x86-64 running
Solaris

Micro Focus installer 313 1.25 GB 626 31

System Z
running SUSE
SLES

Micro Focus installer 287 1.15 GB 574 36

x86-64 running
SUSE SLES

Micro Focus installer 302 1.21 GB 604 46

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x and Red Hat 7, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

• On IBM System z (390), you must have the following operating system libraries installed:

glibc-*.s390
glibc-*.s390x
libgcc-*.s390
libgcc-*.s390x

Visit the Red Hat Web site for more information.

• Oracle's Java Platform, Enterprise Edition (Java EE) 7 or Java 8 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The setup file installs Java 8 u51 32-bit. You can
download Oracle's Java EE from Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.
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• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Visual COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 13
• Database Access on page 14
• Java Development Kit (JDK) on page 14
• XML Extensions on page 14

Application server support for JVM COBOL

Back to Top

Restriction: This topic applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.7 Servlets 2.5

JBoss 6.1 1.7 Servlets 2.5

WebLogic 12.1.1 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.7 Servlets 2.5

WebSphere 8.5 on AIX 6.1 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.7
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.7 is
Java 7.0.11. You can get the HP-UX Java JDK from HP's Web site.
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• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.7
is 1.7.027. You can download Oracle's JDK from Oracle's Web site.

Database Access

Back to Top

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
For details, see the product help for the COBOL development system you used to develop your
applications, under Welcome > Product Information > Installing... > System Requirements... >
Additional Software Requirements > Database Access.

Java Development Kit (JDK)

Back to Top

Compiling
Java

Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is required
for compiling Java. The JDK is downloadable from the Oracle and IBM Web sites. After
installing the JDK, you must put the tools.jar file for the JDK on your classpath, using
a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

After installing the JDK, you need to set up your Java environment.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing COBOL Server for UNIX

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_cobol_server_2.3_platform

2. Run the installer with superuser permissions:

./setup_cobol_server_2.3_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.
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If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_cobol_server_2.3_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

After Installing
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

COBOL Server installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application is installed, you can silently install the license as follows:

• If you have access to the Internet and an authorization code, execute the following commands:

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT\cesadmintool" -term activate AuthorizationCode

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel
\Sentinel RMS License Manager\WinNT\cesadmintool" -term activate 
AuthorizationCode

• If you don't have access to the Internet but have a file from Micro Focus that contains the license string:

For 32-bit Windows environments:

start /wait "" "C:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT\cesadmintool" -term install -f FileName

For 64-bit Windows environments:

start /wait "" "C:\Program Files (x86)\Common Files\SafeNet Sentinel
\Sentinel RMS License Manager\WinNT\cesadmintool" -term install -f FileName

where FileName is the name of the text file that contains all the license strings to be used.

UNIX and Linux Installer Issues

Installing on Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse. When you start
the installation, if the 64-bit version of Java is already installed on your Linux machine, you might not be
able to install Visual COBOL. This is a known issue with the Oracle Java installers for Linux which prevent
you from installing both the 32-bit and the 64-bit versions of Java on the same machine. To work around
this problem:
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• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For example,

untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to install and

run Visual COBOL.

License Infrastructure Installer

On some Solaris platforms, you can receive the following error message when SafeNet license server
needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

• To resolve this issue, wait for the installation to complete and then perform the following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat Enterprise Linux
(RHEL) 7.

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer available) required
a change in the MF SafeNet license installer for this platform and the way you can manually manage the
licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts automatically when
starting your machine. Only on RHEL 7, you must use the systemctl command available with the OS
if you need to override the default behaviour – for example, if you do not want run the MF SafeNet
licensing service at start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the following contents:

----------- start of /usr/lib/systemd/system/MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the machine is booted.

enable Enables the SafeNet Service so it starts when the machine is booted.
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For more information about systemctl, refer to the help available with the RHEL OS.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_COBOLServer2.3.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
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• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.

4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
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5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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New Features in COBOL Server 2.3
Enhancements are available in the following areas:

File Handling
This release contains the following new configuration options:

ACUFH Enables or disables the use of the ACU file handler (ACUFH), which is required to handle
Vision and RM/COBOL indexed files.

ESACUFH Enables or disables the use of the ACU file handler (ACUFH) for file handling operations
running under Enterprise Server. ACUFH must also be enabled for this option to take effect.

Managed COBOL Syntax
The following enhancements have been made to the managed COBOL syntax:

• The TYPE OF type-name[ANY...] syntax enables you to obtain the System.Type (.NET) or
java.lang.Class (JVM) object for a generic class, interface, or delegate.

• The self:: or super:: syntax is no longer required to access inherited data within a subclass.
• The ATTRIBUTE-ID syntax enables you to define new attribute types, which can be used in various

contexts.

Micro Focus Infocenter
The Micro Focus Infocenter Web site (http://documentation.microfocus.com) has been upgraded and now
includes the following improvements:

• Scope being persisted when you select a product documentation in the Product Documentation section
on the Micro Focus SupportLine Web site and choose to view the documentation in the Micro Focus
Infocenter.

• Updated Scope settings - provides the ability to nest four levels deep when setting a scope.
• Scope being persisted between browser sessions once it has been set.
• Creating automatic scopes using the Search Topics icon, .
• A link to change the scope from the search results when there are too many results.
• Improved Boolean search expressions.
• Details included with the search results.
• Help on how to use the Infocenter and how to construct search expressions - available using the

Infocenter Help button, .
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Debugging

Remote debugging does not work for programs running on AIX or HP machines, if you are trying to debug
using Visual COBOL installed on a Linux machine.

Enterprise Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled enterprise servers.
• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server

Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

• Enterprise Server instances will fail to start if they have been configured with the MLDAP ESM module
to use external security and are started using Enterprise Server credentials that are not configured with
"user administration" privileges (that is they do not have an allow update ACE in the "User
Administration" security resource in the Enterprise Server Administration). A fix for this is available if you
install HotFix 1 of version 2.3. of this product.

ICETOOL Emulation

ICETOOL emulation for managed code is not available in this release.

Linking

Changes in the C compiler in Visual Studio 2015 affect the way you link COBOL object code and C object
code built with that version of Visual Studio in the same executable. In this scenario, you must use the
Microsoft link utility and the C runtime libraries directly from Visual Studio, rather than the Micro Focus
cbllink utility, the Microsoft link utility and the libraries supplied with Visual COBOL. You might also need to
specify some additional C runtime libraries - see the Microsoft documentation for more details.

Note that when using COBOL and C object code together, Micro Focus recommends you build and keep
the COBOL and C executables separate, and use import libraries and the Micro Focus C functions for
calling COBOL (see "C functions for calling COBOL" in the product help) to resolve calls between them.

Resource Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need to
undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying using
the WebLogic GUI, you can use the command line. If there are issues with this as well, try reducing the
length of the command (for example, by moving the file to a location with a shorter path).

Setup

• On UNIX, check UNIX Installer Issues before you start the installation.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• CAS Security
• CAS XA Switch modules
• File Handling - External File Handler
• File Locking
• J2EE Connector
• MF Server Administrator (GUI)
• Updated Run-Time System

CAS Security

Back to the list

• The Enterprise Server External Security Facility now includes MLDAP ESM Module 2.0, with a new
algorithm for identifying the best-matching resource-access rule and ACE for resource-access security
checks. This algorithm is faster and matches most customers' expectations. The new algorithm also
provides an optional "username substitution" feature. It can be enabled by setting "rule substitutions" to
"yes" in the [Operation] section in the Security Manager configuration text area. When this is enabled,
the string "${user}" in a resource-rule name will be replaced with the name of the user that makes the
request. For example, a DATASET rule named "USERS.${user}.**" would apply to datasets with the
requesting user's name as the second qualifier. In rare cases, customers with complex, ambiguous
resource-access security rules might see experience changes in behavior as a result of the new
algorithm. The old algorithm is still supported and can be enabled by setting "version 1 authentication"
to "yes" in the [Operation] section of the Security Manager configuration.

2807531 (1097783)

CAS XA Switch modules

Back to the list

• The XA switch modules now support dynamic registration.

2682101 (1092325)
• The XA switch modules now support batch-only operations when multiple XA Resource Managers have

been defined.

2664675 (1091082)
• In Visual COBOL 2.2 update 2, Micro Focus identified undefined run-time behavior when the following

combination of directives was specified: SIGN"EBCDIC", CHARSET"ASCII", and one of the following:
HOST-NUMMOVE, HOST-NUMCOMPARE or SIGN-FIXUP. Previously (Visual COBOL 2.2 update 1 and
earlier), if this combination was specified, the SIGN”EBCDIC” directive should have been ignored, to
avoid a mixture of ASCII and EBCDIC characters; however, SIGN”EBCDIC” was still being honored,
resulting in undefined run-time behavior. Therefore, this combination of directives is now invalid for
Visual COBOL 2.2 update 2 or later, and if specified, will be rejected at compile time.

2786397 (1095265)
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File Handling - External File Handler

Back to the list

• Custom file handlers (using DYNREDIR) are now called for each part of a concatenated file.

2795077 (1096322)

File Locking

Back to the list

• In versions prior to Visual COBOL 2.3, the semantics of the sharing phrase specified in an OPEN
statement or used within a call to CBL_OPEN_FILE were not correctly applied in some cases on UNIX
and Linux platforms. From version 2.3 onwards, the sharing phrase is correctly honored when the
tunable strict_file_locking=true is set, which is the default setting.

Example of potential changes in behavior:

• Process-A opens a file with read-only access and a sharing mode that denies other processes write
access (SHARING WITH READ ONLY).

• Process-B then attempts to open the file with read-only access and a sharing mode that denies
other processes read access (SHARING WITH NO OTHER).

With strict_file_locking=true, Process-B is unable to open the file, because Process-A has
successfully opened the file allowing only read access.

With strict_file_locking=false, Process-B successfully opens the file.

If your application encounters unexpected OPEN conditions or fails to open files, it might be as a result
of the new file locking behavior. In such circumstances, we recommend that you review the file locking
and sharing requirements of your application and refactor your source code to work with the default
setting. The original file locking and sharing behavior can be restored by setting
strict_file_locking=false.

J2EE Connector

Back to the list

• This release provides a new command-line argument to Java, mf.ssl.algorithm, which can be set to an
appropriate algorithm.

2799213 (1096684)

JVM COBOL

Visual COBOL for Eclipse now ships with Eclipse 4.4.2 (Luna). A consequence of this is that if your
application also contains JVM COBOL code that was built with a version of Visual COBOL prior to version
2.3, those parts of your application must be rebuilt; otherwise you will experience errors at either
compilation or run time.

MF Server Administrator (GUI)

Back to the list

• Passwords that entered through either the MFDS or the ESMAC interface now use the same encoding.

2792382 (1096011)

Updated Run-Time System

Back to the list
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• COBOL Server now provides an execution environment capable of running applications that were each
built using different development products. A consequence of this is that if your application has a main
COBOL executable (.exe) that was built with a version of Visual COBOL prior to version 2.3, you should
ensure that the executable is rebuilt and packaged with the new run-time system. You can rebuild from
the IDE or the command line.

Other COBOL subprograms built with previous versions of Visual COBOL are not required to be rebuilt.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• CASRDO
• Compiler
• Documentation
• ecijava
• Enterprise Server
• File Handling
• IBM Language Environment for OS/390 and VM Support
• Library
• Micro Focus Common Client
• Micro Focus Communications Server
• Micro Focus Directory Server
• Micro Focus Server Administrator (GUI)
• MLDAP API Interface
• Run-Time System
• Setup
• SQL: OpenESQL
• XML Extensions
• XML Support

Adis

Back to the list

• Paste now works as expected when pasting into numeric items under MS(2) with ACCEPT statements.

2800091 (1096820)
• When the MS Compiler directive is set, ACCEPT with EMPTY-CHECK now supports manually entering

of a zero for numeric items and a space for alphanumeric items.

2795831 (1096324)
• When using ACCEPT WITH UPDATE with the MS Compiler directive, the pre- and post- display

behavior is now the same as that of the MS compiler.

2795709 (1096311)

CASRDO

Back to the list

• When trying to access the Catalog page from casrdo45, the JESSPOOL class was checked instead of
DATASET.

2819633 (1099350)
• The ESMAC Spool view is now sorted correctly when using a filter criteria.

2798643 (1096681)
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Compiler

Back to the list

• A program compiled with the INIT-BY-TYPE directive that contains 'PROGRAM-ID IS INITIAL' syntax
and declarations of index names or data items now produces correct intermediate code.

2831469 (1100741)
• Programs compiled with DIALECT"RM" and containing 'PROGRAM-ID .. AS' syntax now execute as

expected.

2830956 (1100700)
• The CP preprocessor used in conjunction with the COBSQL preprocessor now correctly replaces any

text affected by the COPY... REPLACING statement.

2826558 (1100370)
• When using the WINDOW1 preprocessor, specification of the AUTOCLOSE option no longer prevents

subsequent preprocessor options from being actioned.

2822206 (1099687)
• The output from the SETTINGS compiler directive now also appears for programs specified via the

ILSOURCE option.

2822102 (1099604)
• The XML GENERATE statement now functions as expected in programs containing the DECIMAL

POINT IS COMMA clause.

2821786 (1099599)
• The XML GENERATE statement now executes correctly when the specified FROM operand is a group

containing nested ODO tables (which is only possible with the ODOSLIDE directive).

2821779 (1099600)
• The INITBYTYPE compiler directive no longer causes spurious flag messages with DIALECT(OSVS).

2820920 (1099488)
• The LINE-COUNT Compiler directive now operates as expected.

2817442 (1098979)
• The maximum size of data items in a program compiled with the DIALECT(ENTCOBOL) directive now

correctly reflects the respective mainframe values in the latest version of Enterprise COBOL.

2816030 (1098926)
• The Compiler now rejects the use of special register names as arguments for reserved word altering

directives. You can only specify standard reserved words with these directives.

2813931 (1098542)
• Data names that start with a numeric digit and contain DBCS characters are now accepted by the

Compiler, as expected.

2813223 (1098456)
• A MOVE operation of an alphanumeric literal to an unsigned numeric DISPLAY field under RM/COBOL

emulation now executes as expected.

2812561 (1098446)
• Data names longer than 30 characters are now flagged when specifying the FLAG option with a

mainframe argument and not just when using the equivalent full DIALECT.

2810924 (1098133)
• Compiling a program with the COBSQL preprocessor, which contains a COPY REPLACING statement

with trailing spaces in the replacement pseudo text, now works as expected.

2807470 (1097737)
• Compilation of a program containing a GO TO statement that references an undeclared procedure

name, and has the RESTRICT-GOTO directive set no longer results in a run-time exception.
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2807280 (1097616)
• A user function that specifies a PIC 1 item as a RETURNING field now receives an appropriate compile-

time error.

2806037 (1097470)
• The addressability of a linkage data item is now checked correctly.

2805523 (1097453)
• Compilation with a mainframe dialect, of a program containing a CALL statement with a mixture of

non-01 level group items and literals, now proceeds as expected with no internal error produced.

2803613 (1097190)
• A debugger query of a condition name with a negative literal VALUE now returns the expected result.

2801993 (1097607)
• The combination of a mainframe dialect and SOURCEFORMAT(FREE) no longer produces unexpected

compiler errors referring to tokens being in the wrong area of source.

2800332 (1096911)
• The specification of an alphanumeric literal in the VALUE clause of a DBCS data item (i.e. the G\N

prefix is missing) is now accepted as an MF extension. This still generates an error under mainframe
dialects, but can be hidden/suppressed like any other flag message.

2798426 (1096574)
• Under DIALECT"MF", the Report Group description entry now permits the NEXT GROUP NEXT PAGE

clause without a LINE clause.

2798367 (1097201)
• It is now possible to specify fixed-point numeric literals without a trailing separator space before the next

token or operator. This provides a better mainframe emulation.

2797274 (1096469)
• A new CP option, ANYCOPYCASE, now provides more flexibility in matching the case of copybook

names.

2797035 (1096494)
• Previously, numeric items that used a decimal point and the OR sign were truncated when using the MS

display syntax under MS(2).

2795709 (1096308)
• DBSPACE(MIXED) directive has been implemented to allow comparison of mixed single and double-

byte spaces to the SPACE figurative constant.

2679222 (1092427)
• When importing aVisual COBOL source file, the generation of a CBLast (COBOL Abstract Symbol

Table) file no longer hangs when instructed to process a COBOL.DIR file.
• Mixing alphanumeric and national items in intrinsic functions which only allow one type now produces a

syntax error.
• A source line longer than the maximum supported by the compiler no longer receives an error about

truncation if the line is simply a comment.
• An error during compilation, when creating .int files when the COBDATA directive is set, has been fixed.
• An error reading the default directive file $COBDIR/etc/cobol.dir when COBDATA is set during

compilation has been fixed.

• A bug in accepting a field containing double-byte and single-byte characters has been fixed.

2829369 (1100513)
• A bug during compilation has been fixed, which caused a Run-Time System error 114 when generating

32-bit programs using the OPT directive, containing decimal operations.

2819838 (1099305)
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• An error has been fixed in COMPUTE statements of the following form: COMPUTE a = b / constant
where a and b are COMP-3 or DISPLAY; a has greater than 19 digits and b has less than or equal to 19
digits, and constant is a literal which is a power of 10 (such as 10, 100, 1000, etc.)

2808008 (1097715)

• An error in managed COBOL that resulted in EXIT PROGRAM or GOBACK statements not being
executed has been fixed. The error could occur when perform ranges overlapped.

2825425 (1100162)
• When compiling for JVM COBOL with the ILSMARTLINKAGE directive, pic 9v9 items used as VALUE

parameters are now generated correctly.

2815477 (1098847)
• An illegal instruction 'invokespecial' is no longer generated. Previously, in some circumstances, this

could be generated, leading to a verification error on class load.

2811246 (1098205)
• When compiling a large program for JVM COBOL, the use of performtype(osvs) or performtype(rm) with

declaratives no longer leads to bad code generation and invalid jump errors when loading the resulting
class.

2695030 (1093952)

• Very large screen section records no longer produce unpredictable errors when generating managed
COBOL code.

2830002 (1100580)
• Programs that contain report-writer syntax, and are compiled with either PERFORMTYPE(RM) or

PERFORMTYPE(OSVS), now behave as expected.

2824931 (1099963)
• When forming externalised names for ILSMARTLINKAGE, any double-byte hyphen (or similar)

characters are now removed from the name.

2822491 (1099668)
• For class programs containing COBOL files declared in the OBJECT section, it is now possible to

explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2819597 (1099273)
• The use of the SCREEN SECTION CONTROL phrase in .NET unverifiable code no longer causes the

generation of illegal code.

2818736 (1099170)
• An INITIALIZE statement applied to a file record, which is not otherwise referenced, now correctly

initializes the whole record area.

2817756 (1099017)
• Verification or run time errors are no longer produced when NUMPROC(ACOS) is specified, and a level

88 item is declared for a numeric item in the Linkage section of your program.

2815137 (1098693)
• Opening a XAML file in a WCF client project no longer causes an unhandled exception to be generated.

2813004 (1098525)
• You can now use an external member reference as a target operand for the INITIALIZE statement. In

previous versions of the product, you could not.

2812151 (1098318)
• In previous versions of the product, compilation errors resulted when the NOILNATIVE directive was

specified when compiling programs that used the OCCURS ANY syntax for defining tables. This is no
longer the case, and the NOILNATIVE directive has no effect on such tables.

2809432 (1097893)
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• The INITIALIZE statement is now working as expected when applied to a group item where an
OCCURS subgroup follows a FILLER data item. Previously, this could produce bad code, initializing
incorrect areas of the group.

2805149 (1097372)
• For class programs containing COBOL files declared in the OBJECT section, it is now possible to

explicitly add the program to a run unit. Previously, this would cause a run-time exception.

2802641 (1099053)
• When compiling for managed code (.NET or JVM), a zero length literal used as a value for a PIC N data

item no longer crashes compilation with run-time error 181.

2799176 (1096677)
• If a method has an optional parameter with a default value of System.Reflection.Missing.Value, and that

parameter was omitted in a method invocation expression, that parameter was being passed as null,
instead of the correct default value. This affected a number of methods - for example,
Microsoft.Office.Interop.Excel.

2796911 (1096408)
• Comparisons between PIC N or PIC G items and ALL hex-literals are now working correctly.

2795393 (1096266)
• Managed code that includes operands of the form 'typedef-name AT pointer' now generates correctly.

(607855)

Documentation

Back to the list

• The product help now includes the optional attributes for the ‘container’ objectclass definition used by
Enterprise Server external security.

2801420 (1096977)
• The product help now includes information about how to retrieve the Run-Time System error code from

a file status code returned as a decimal value. For example, if you receive 14657 as a value for the file
status, this is a decimal value. This converts to 3941 HEX. The second byte of this value, 41, must be
converted to Decimal before looking at the RTS error code - thus this HEX value then represents an
extended file status code of 9/065 which means the error code is COBRT065, a locked file status.

2822853 (1099769)
• The MFJSTATS topic has been updated to clarify that this refers to a COBOL SORT operation.

2828881 (1100446)
• The product documentation about the START statement and Relation Conditions now states that THEN

may be used instead of THAN.

2799291 (1096903)
• The default setting for the ES_ESM_PLTPISEC variable is NONE.

2821810 (1099672)
• Additional information has been added to the description of the CASSI1400 error message.

2821806 (1099711)
• The AdminAPI resource class has been documented for ESF features.

2815870 (1098815)
• The Enterprise Server documentation for Retain Periods has been updated to include additional

information specific to spool output.

2790146 (1095777)
• The LISTCAT topic in the documentation has been updated to reflect accurate column headings and

descriptions for output format.
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2789939 (1095765)
• The explanation of error message CASCF0052S has been updated with UNIX-specific information.

2821745 (1099737)
• Topic amended to refer to entry_point_mapper rather than entry_name_mapper.

2807744 (1097673)
• Details on MF_MVSJOB environment variable added.

2797526 (1096488)
• The Micro Focus Communications Server now supports rotational log files. To enable this feature, you

need to edit the mf-server.dat file, which resides in the product's bin directory (Windows), or the
$COBDIR/etc directory (UNIX). The mf-server.dat file contains details of this feature under the [logging]
paragraph, and full documentation is provided in the online help under "Server Instance Diagnostics:
CS Console".

2675327 (1092083)
• NONCONNECTED has been added to the list of attributes of DECLARE.

ecijava

Back to the list

• Stateless Java ECI requests no longer cause memory leaks in MFCS as a result of abandoned
sessions.

2822108 (1099645)

Enterprise Server

Back to the list

• When using an EXCI link and a PPT defined with commarea 32767, the modified commarea was not
reflected back to the caller.

2830739 (1100654)
• It is possible to configure a Visual Studio or an Eclipse project to perform emergency debugging of an

application running in an enterprise server even when the server is operating in production mode (with
dynamic debugging disabled). To prevent this, starting with this HotFix, you can use the environment
variable ES_PRODUCTION in the server’s [ES-Environment]. When set to Y, this variable prevents the
IDE from initiating a debug session.

2825848 (1100160)
• When using a secure region and when the environment variable

ES_ESM_DISABLE_DFLTUSER_ESMAC is set to Y, clicking on the Home button in the signon page
now correctly opens the MFDS page.

2824772 (1099949)
• When the casspool.dat file is shared across multiple servers (excluding cluster scenarios), ESMAC

displays all jobs, including those that are not running in the current server. However, it is only possible to
cancel jobs that are running in the current server. For other jobs the CANCEL button is disabled.

2824230 (1099917)
• It is now possible to start a BATCH printer in ESMAC if its name consists of space characters only but

an exit name is provided.

2819122 (1099216)
• When using ESMAC, Enterprise Server now correctly loads the MFESMAC resource class, when

necessary. Previously, it was loading the ESMAC class.

2814789 (1098652)

32 | Resolved Issues



• You can now use the environment variable ES_ESM_DISABLE_DFLTUSER_ESMAC in order to disable
the ESMAC default user. When this variable is set, the "DEFAULT" button on the logon screen is
disabled and a valid userid and password must always be entered.

2813092 (1098438)
• DBCS fields are now processed correctly when the PS attribute is set in the DSECT rather that defined

in the MAP in single field, groups and OCCURs.

2811683 (1098233)
• Web service timeout values are no longer truncated to two digits.

2792860 (1096024)
• An issue with dynamic debugging has been fixed where, previously, the ports that were freed were not

being reallocated.

2785911 (1095510)
• An artificial restriction on the size of cookies passed when invoking ESMAC requests has been

removed. Previously, this was causing Run-Time exceptions.

2692460 (1094557)
• The characteristics of an FCT that references a cataloged file are now refreshed on each file open.
• If a file was already present, the date for an open request was not sent to the file handler.
• Open and close operations are no longer recorded in the transaction logs and replicated by extension

when they are associated with open input requests.
• A secondary node in a group no longer attempts to take over the role of a primary node. The entire

group now initializes correctly and all roles are assigned as expected.
• Microsoft's Internet Explorer versions 10 and 11, by default, does not use the current form name. As a

result, when invoking the javascript functions, the form name was not correct and the product behavior
was wrong. This has now been fixed.

• This release provides a number of enhancements to the CAS administration console:

• Improvements have been made to the log-in mechanism for situations where you are using an
External Security Manager to secure the MFDS and Enterprise Server, and you are logged on to
MFDS and ESMAC using different user accounts – for example, "user1" and "user2", respectively. If
you navigate from ESMAC to MFDS and you log off "user1" from the MFDS, this will now
automatically log off "user2" from ESMAC as well.

• When using an external security manager, if you sign off from ESMAC, the sign on screen no longer
preserves and displays the userID of the last user that was logged on.

• An issue with the "Home" link in the ESMAC sign on page when the environment variable
ES_ESM_DISABLE_DFLTUSER_ESMAC is set has been resolved.

2814494 (1098607)

• A memory leak occurred in the External Security Facility's MLDAP ESM Module in some HotFix
releases of COBOL Server 2.2 Update 2.

2833758 (1101024)
• When using the Enterprise Server External Security Facility with the audit feature, some audit events

generated by ESF Admin requests (such as ADDGROUP or ALTGROUP commands specifying many
group members) may include too much information to fit in a single audit event. These parameters are
now split across multiple audit events of category 5, type 3. Each split parameter has a unique number
(per process), and each piece of a split parameter has a sequence number. The original event will
contain a string with the split parameter identifier.

2827010 (1100238)
• The new resource access authorization processing in Enterprise Server's MLDAP ESM Module (LDAP-

based security), introduced in HotFix releases of COBOL Server 2.2 Update 2, now correctly handles
cases where multiple access control entries have the same rank. For example, this may apply when all
group mode is enabled and an Access Control List (ACL) contains Access Control Entries (ACE) for
different groups the user belongs to.
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2826650 (1100313)
• In COBOL Server 2.2 Update 2 HotFix 06 only, when Enterprise Server External Security is used with

the "Version 2 Authentication" mode enabled, some ACEs might not be processed or applied. This has
been fixed.

2826650 (1100195)
• When using the Enterprise Server External Security Facility (ESF) with auditing enabled, and using the

ESF Admin API (programmatically or with the Enterprise Server Administration web interface or the
esfadmin command-line tool) to make certain changes to security data, very large audit events could be
generated. In some circumstances these could cause the Audit Manager process to crash or hang the
program making the request. This has been corrected by truncating parameter information for very large
security administration requests.

2825505 (1100158)
• When using Enterprise Server External Security Facility (ESF) with the optional Referential Integrity

User Exit, integrity constraints are now ignored for Access Control List (ACL) actors containing wildcard
characters. This enables ESF Admin actions that include resource access control ACLs containing
wildcard actors.

2824117 (1099908)
• The optional ESF Referential Integrity user exit module no longer fails with an LDAP "filter error"

message when processing certain resource-rule commands, such as ALTRESOURCE, for resource
rules with names that include an asterisk, "*".

2824049 (1099884)
• The "referential integrity" sample user exit module for Enterprise Server External Security no longer

causes the MFDS process (Enterprise Server Administration) to terminate when external security with
the exit is configured for MFDS, and MFDS is used to add a user or to perform some other security
administration tasks.

2823947 (1099880)
• A new MFDS command line startup option (-b) is now available. Specifying -b disables the

establishment of anonymous MLDAP API sessions.

2818587 (1099264)
• This release enables you to prevent an Enterprise Server Monitor and Control (ESMAC) user from

displaying an enterprise server's environment variable settings using the "Env. Vars." button or the direct
URL. To enable this feature, you need to create a new element (ENV*) in the LDAP schema in the
CN=MFESMAC group below CN=Enterprise Server Resources.

This release includes an updated copy of the supplied LDIF import files that contain this change. Once
this element is installed in the security manager, you can control the visibility of the environment
variables page by configuring the group/user access rights using the microfocus-MFDS-Resource-ACE
attribute.

2811696 (1098264)
• The number of security manager user group members displayed by the Enterprise Server

Administration and the esfadmin tool is no longer limited to a maximum of 1024.

2807579 (1097703)
• Trying to use the SNMP audit emitter with Enterprise Server no longer fails with a run-time system error

114.

2800729 (1096951)
• The MLDAP ESM Module, part of the Enterprise Server External Security Facility, now supports

"nested" user groups where one user group can contain another user group. Members of the contained
group belong to both groups. This enables administrators to define very large user groups as well as
hierarchies of user groups.

2510993 (1078988)
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• A new option, "LITERAL=YES" has been provided in the Enterprise Server External Security Facility's
Administration API, and in the esfadmin command-line utility. When this is set, "*" is not interpreted as a
wildcard when using any of the administrator's LIST commands. This is particularly useful for listing
resource access rules that include "*" in their name. Search the product documentation for esfadmin for
more information.

• Oracle and OCI XA switch modules leaked memory when using user personalization.

2830922 (1100676)

• When issuing an ENQ change request in a cluster environment, the request to change the lock type
was being sent to the GLM but not processed locally. It is now also being processed locally.

2826218 (1100148)
• During a cluster RECONNECT request, each cluster client sends a list of active locks and the GLM re-

populates the Global ENQ. Since the introduction of the VSAM shared options, the lock may also
contain a tca ptr which is used to store the client's casmgr information. This is required for lock with
persistence server. A pointer set to low-value was sent as part of a GIVELOCK request, but on the GLM
that value was not used. This causes a run-time system error 114 in casgreqt on the RECONNECT/
GIVELOCKS function. This fix allocates the required tca for client casmgr for a RECONNECT request,
sets up the pointer depending on the lock persistence type as well as the clients casmgr PID.

File Handling

Back to the list

• You now receive an RC16 error message, if a PDSM file is missing from a list of concatenated DD's.

2821187 (1099770)
• Indexed files are no longer corrupted when their file size limit is reached.

2817599 (1099359)
• When lock mode is set to 'automatic', with single record locking, the lock from the previous operation is

released at the start of the next file operation; this is to avoid an ABBA deadlock situation occurring.

2816981 (1099052)
• A new file handler configuration file option (STRICTLSEQ) has been added. Only use this option if

instructed to by Support.

2814458 (1099019)
• RM and ACU files accessed from Visual COBOL no longer crash with a 114 error for I/O operations on

a non-existent optional file opened for input. An appropriate error code is now returned.

2809718 (1098141)
• MFSORT now takes the record length from a previous output file, if its record length is specified, rather

than defaulting to the value in the SORTIN statement.

2808188 (1098243)
• The rollback recovery process is now working as expected.

2802180 (1097066)
• This release provides a new format of the dataset allocation override rules file that supports multiple

conditions.

2783138 (1095007)
• The ACUFH interface between the MF File Handler and the RM File Manager will no longer report an

05 status (optional file created) to more than one COBOL run unit for creation of the same file. The 05
status will be reported to the COBOL run unit that actually created the file. The RM File Manager that
runs under ACUFH and the Micro Focus File Handler for Visual COBOL now includes optimizations that
enable it to use pread and pwrite system calls and to report status 99 (record locked) quicker. These
optimizations match the optimizations added to the RM File Manager within RM/COBOL.
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• The file handler configuration file (extfh.cfg) now supports the following options:

• ACUFH=ON/OFF - enables or disables any calls to ACUFH. ON by default.
• ESACUFH=ON/OFF - enables or disables calls to ACUFH while running under Enterprise Server.

OFF by default.

Note: As a result of this change, calls to ACUFH are now disabled by default when running under
Enterprise Server.

• Copying an ESDS file no longer causes an RTS114 error.

2811583 (1098244)
• When a file is closed under Enterprise Server, the file's details are correctly removed from Fileshare.

Previously, some details were not removed.

2810549 (1098111)
• When handling indexed files, the correct .IDX file is now being processed.

2803247 (1097279)

IBM Language Environment for OS/390 and VM Support

Back to the list

• The Language Environment utilities are now available as Java managed code.

2826067 (1100134)
• Mainframe Language Environment support (LE Services) is now available in Micro Focus Visual

COBOL and COBOL Server.

2799388 (1097806)
• The Language Environment functions CEEGMT, CEEUTC and CEELOCT now return the number of

seconds to millisecond precision.

2796098 (1098276)
• The I-S-Info field of the Language Environment (LE) Feed-Back group has been changed from a pointer

to a PIC S9(9) BINARY item.

Library

Back to the list

• Using a dd_ environment variable to specify the path used in CBL_LOCTE_FILE now works as
expected.

2822153 (1099632)

Micro Focus Common Client

Back to the list

• The Micro Focus Common Client, used by COBOL Web Service proxies and other components, now
allows HTTP URLs with certain characters such as ":". It also no longer rejects correct URLs with "%xx"
escape sequences.

2828629 (1100520)

Micro Focus Communications Server

Back to the list

• Certain Enterprise Server administration actions such as notifying a running enterprise server of a
security update could cause MFCS to hang.

2784219 (1095045)
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Micro Focus Directory Server

Back to the list

• The generated HTML fragment displayed for an individual resource entity element when using the
Enterprise Server Administration HTML GUI to administer an external Security Manager was
overflowing a fixed size buffer. This is now allocated based on the actual length required.

2828732 (1100545)
• Corrected the resource entity that the Enterprise Server Administration GUI checks to determine

whether the external Security Manager administration pages are accessible to a logged on user. The
correct resource entity is "User Administration" under the "Enterprise Server Administration" resource
class.

2828553 (1100539)
• Require read permission before returning repository data for authenticated users if MFDS is started with

the -b option.

2828228 (1100364)
• Access to password data is prevented on the security manager edit page in the Enterprise Server

Administration HTML GUI.

2827942 (1100333)
• When MFDS is secured using an external Security Manager, it does not display internal security

configuration pages which no longer have an effect.

2827786 (1100314)
• Correct display of user session data in the Enterprise Server Administration HTML GUI.

2826210 (1100161)
• An issue with the persistency of the audit output option in the MF Directory Server security configuration

has been resolved.

2824201 (1099902)
• Honor the trace flags values set in an Enterprise Server XML configuration file when importing it into

MFDS via the -g command line option.

2823855 (1099846)
• An issue with storing certificate passphrase in the Enterprise Server Administration HTML GUI form

data has been resolved.

2820846 (1099448)
• The resistance of the Enterprise Server Administration HTML GUI log-on page to cross-site scripting

attacks has been increased.

2819223 (1099212)
• Improve browser caching control to increase security of the Enterprise Server Administration HTML

GUI.

2819218 (1099209)
• An issue with storing certificate passphrase in the Enterprise Server Administration GUI has been

resolved.

2819212 (1099207)
• The Enterprise Server Administration web page makes additional authorization checks before

displaying screens.

2819069 (1099192)
• The Enterprise Server Administration web page no longer displays sensitive session data.

2818974 (1099178)
• Password length restriction has been fixed in the Enterprise Server Administration login page.

2818973 (1099179)
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• Enterprise Server Historical Statistics Facility (HSF) configuration can now be exported and imported
via the mfds -x and -g command-line options.

2815030 (1098695)
• Previously, the Enterprise Server Administration journal export to text truncated the exported file.

2802793 (1097108)
• It is now possible to expand and collapse items within the tree view of the external security manager

security resources in Enterprise Server Administration.

2801421 (1096979)
• The MFDS GUI now correctly displays external Security Manager resource ACL strings that are greater

than 3K byte length.

2800727 (1096978)
• The MFDS -x XML export option was not exporting Windows Monitoring and Management configuration

values for enterprise server instances.

2794382 (1096428)

Micro Focus Server Administrator (GUI)

Back to the list

• If access to Enterprise Server Administration is restricted by use of an MLDAP ESM-based external
Security Manager, you can now configure a user to have access to the "Security" menu item but not to
the "Options" menu item.

2804728 (1097916)
• Previously, when expanding or collapsing items in the tree view for external Security Manager within

Enterprise Server Administration, items associated with a user or a group no longer would always move
to the top of the resource list.

2803399 (1097848)
• If MFDS is configured to use an external Security Manager with the Windows "user" class, it is not

possible to edit the users from the MFDS GUI and you receive a warning.

MLDAP API Interface

Back to the list

• The MLDAP ESM module now recognizes a wider range of errors that indicate that the specified LDAP
server is unavailable and, if configured, the server will retry to establish a connection.

2799921 (1098128)
• The MFDS GUI and the ESFADMIN utility now display the pages with LDAP query results.

2681539 (1092705)

Run-Time System

Back to the list

• A run unit created with the RuntimeServices RunUnit class no longer causes an exception to occur if no
COBOL code has been executed inside it before the RunUnit is terminated with a StopRun() method.

2826239 (1100198)
• You now receive a correct error code when the product does not find a file located on a network drive.

2822161 (1099619)

• Micro Focus COBOL Server 2012 and COBOL Server 2013 now support Microsoft Windows XP and
Windows Server 2003 platforms.
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2804421 (1097492)
• The RM/COBOL version of the “SYSTEM” library routine nows supports the return of an exit-code, for

native COBOL applications.

2830238 (1100599)
• When using ADIS DISPLAY statements and the RELDECDELIM=0D0A file handler configuration option

on UNIX, you could receive a Run-Time System error during process termination.

2829860 (1100601)
• On UNIX platforms, if the Audit Manager process is recycled, dependent processes will continue to

pass events to it after it's recycled; previously, these processes would hang.

2810770 (1098085)
• On a 32-bit Enterprise Server running on Windows, tasks that are blocked in the operating system can

now be canceled without terminating the SEP process.

2807997 (1097918)
• An error in generated code when initializing comp-2 data items from fractional literal values has been

fixed.

2800938 (1096960)
• The tunables default_cancel_mode and subsystem_cancel_mode both have a new setting, which

enables programs to remain in memory after they are canceled; this is opposed to the default behavior,
which physically removes .dll files and shared objects from memory when they are canceled.

2690881 (1096628)

Setup

Back to the list

• A problem with the product setup file handling install locations has been fixed.

2802386 (1097065)

SQL: OpenESQL

Back to the list

• When compiling for ODBC, the OpenESQL preprocessor failed to generate correct SQL code for some
large SQL statements.

2832617 (1100892)
• When compiling a WCF Service application with the SQL(DBMAN=ADO) directive, the OpenESQL

preprocessor attempted to generate SQL interface code, resulting in a COBCH002 error.

2827979 (1100367)
• The GetHire stored procedure sample showed that a COBOL CLR stored procedure could cause an

exception to be thrown when using stored procedure definition files, and when compiled without
SQL(DIALECT=MAINFRAME).

2827854 (1100318)
• Run-time exceptions sometimes resulted from dynamic COBOL calls in stored procedures.

2819325 (1099263)
• The OpenESQL runtime sometimes generated an index out of range error on SQL statements in

managed applications when the PID generated by the OpenESQL preprocessor for each method was
not unique.

2815075 (1098749)
• A problem where a stored procedure that uses DIALECT=MAINFRAME could throw an exception if the

HCOSS stored procedure remapping table had not been deployed to the database has been fixed.

2809927 (1097972)
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• The OpenESQL preprocessor did not support SELECT statements coded with a colon (:) on host
variables after the INTO clause for ORACLE PROCOB migration applications.

2596427 (1086198)
• The OpenESQL preprocessor has been enhanced to allow the use of PIC S9(5) COMP-5 host variables

for INTEGER data on programs migrated from Pro*COBOL.

2596426 (1086197)
• When using SQL(DATE=EXTERNAL) with Oracle, timestamp values were formatted incorrectly. This

has been change to correctly format timestamp values according to the setting of
NLS_TIMESTAMP_FORMAT.

2596425 (1086196)
• When SQL(PROCOB) is set, Oracle date and timestamp result types fetched into PIC X(n) host

variables are truncated without warning.

2596424 (1086195)
• An SQLCODE incompatibility existed between Pro*COBOL and OpenESQL ADO.NET. This has been

corrected. Setting SQL(PROCOB) now also sets SQL(CHECKSINGLETON). When SQL(PROCOB) is
set, OpenESQL error codes in the SQLCA are converted to Pro*COBOL-compatible error codes, which
are controlled by a new file, mfpcocds.txt. This file is delivered in %ProgramData%\Micro Focus
\SQLCODES by default.

2595728 (1087599)
• The OpenESQL runtime for ADO.NET returned times using a 12-hour clock. It now returns times using

a 24-hour clock.

• For managed-code projects, PF_RO_CURSOR and other BEHAVIOR primitive directives were not
available from the User Interface.

2833926 (1101049)
• Some problems related to using ASSOCIATE with the Host Compatibility Option for SQL Server where

the stored procedure name was supplied in a host variable have been fixed.

2831480 (1100747)
• HCO with SQL Server (HCOSS) using the ADO.NET run-time system exhibited a problem retrieving

result set locators on the second call and subsequent calls to a stored procedure.

2830688 (1100659)
• The SQL CLR wrapper program generated by the Generate SPD File tool caused errors during

deployment when it contained one or more data types exceeding 8000 bytes in size. To eliminate these
errors, the Generate SPD File tool now generates the SQL CLR wrapper program with MAX SIZE = -1.

2830545 (1100650)
• PIC X host variables passed to the server as variable-length data with trailing blank suppression

sometimes caused OpenESQL to return different query results than some earlier versions of this
COBOL development product.

2829810 (1100685)
• When generating a COBOL wrapper program, the Generate SPD File tool did not support the passing

of all parameters for a SQL CLR Stored Procedure definition routine as fixed length. To resolve this, a
new option, GENFIXEDLENGTH, has been added.

2829499 (1100629)
• A number of issues with PostgreSQL record logic and error handling have been fixed in OpenESQL's

run-time systems for ODBC and ADO.NET.

2828058 (1100338)
• When the SQL(PROCOB) directive is set, OpenESQL for ADO.NET now supports anonymous PL/SQL

blocks and the following host variable types: SQL-CURSOR SQL-ROWID SQL-BFILE SQL-BLOB SQL-
CLOB SQL-NCLOB
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2825199 (1100003)
• When compiling with the SQL(PROCOB) directive, the OpenESQL preprocessor sometimes generated

incorrect SQL code when a host variable reference in COBOL was split over multiple lines.

2825194 (1099997)
• When using the SQL(CHECK) directives with SQL TYPE CLOB host variables, compilation sometimes

failed.

2819480 (1099342)
• Windows GUI projects compiled with the SQL compiler directive might throw a

MicroFocus.COBOL.Program.COBOLStopRunException on GOBACK.

2816463 (1098907)
• The insertion of more that 8000 characters into a SQL Server VARCHAR(MAX) column from a PIC X(n)

host variable caused a data truncation error.

2814679 (1098675)
• When SQL(TARGETDB=ORACLE) was set and the FOR UPDATE clause was used to enable row

locking, this combination could sometimes trigger a runtime failure. SQL(TARGETDB=ORACLE) is no
longer required to enable row locking via FOR UPDATE clauses on queries.

2814613 (1098624)
• A 114 error on DISCONNECT sometimes occured due to a long-standing bug in Oracle ODBC drivers.

This release provides a workaround. The ODBC specification states that the ODBC row status array is
an array of 2-byte integers, but some Oracle ODBC drivers from Oracle 11 onwards have been
observed to use either 4-byte or 8-byte integers. The OpenESQL runtime for ODBC now automatically
detects the element size used by the driver when an Oracle connection is opened, and adapts its
behavior accordingly.

2813428 (1098480)
• OpenESQL now supports OUTPUT clauses in SQL Server INSERT, UPDATE, and DELETE

statements. HCO for SQL Server now supports the DATA-CHANGE-TABLE-REFERENCE clause.

2812940 (1098424)
• An SQLCA error message occurred when inserting a record into a table using a SQL CLR stored

procedure with a VARCHAR (max) column where the host variable was more than 8000 bytes.

2812261 (1098390)
• The OpenESQL preprocessor incorrectly generated a COBES0100 error when compiling code that

contained GEN-GV-FROM-GROUP and the same host variable used multiple times in same SQL
statement.

2811682 (1098231)
• The OpenESQL preprocessor reported an error for LOCK TABLE statements encountered when using

an Oracle database with the SQL(CHECK) compiler directive option.

2808579 (1097797)
• When using the SQL compiler directive option to compile a program that contained no SQL statements,

a 153 trap occurred when the OpenESQL preprocessor encountered SQLCODE defined as COMP.

2808076 (1097758)
• The OpenESQL preprocessor sometimes generated a "COBCH0302 IF....ELSE or scope-delimiter

mismatch" error if a program defined SQLCODE separately as COMP.

2807937 (1097702)
• The OpenESQL preprocessor sometimes generated a STOP RUN rather than a GOBACK at the

program end, which sometime caused improper termination for subroutines not coded with one or more
GOBACK statements.

2807272 (1097624)
• The OpenESQL preprocessor produced a COBES0125 or COBES0112 error message when it

encountered indicator variable arrays used with non-host array variables.
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2805207 (1097457)
• COBOL SQL CLR stored procedures can now open connections to other databases using EXEC SQL

CONNECT statements. For type 6 CONNECT statements, this requires using a post-deployment script
to alter the connection string for the OpenESQL runtime such that it runs with EXTERNAL_ACCESS
privilege. For other CONNECT statement formats, INSAFE privilege is required. Use SQL Server
authentication rather than Windows authentication for external connections.

2804010 (1097230)
• In some situations, the OpenESQL pre-compiler incorrectly generated a COBES0125 error, "<variable>

should be defined with an OCCURS clause".

2802029 (1097036)
• The ODBC ECM incorrectly generated swap logic for COMP fields on singleton SELECTs in managed

applications which could result in field corruption if the variable was used in a WHERE clause.

2801806 (1097049)
• The OpenESQL Assistant generated copybooks using the same size for DATETIME2 columns

regardless of their definitions. The OpenESQL Assistant now generates PIC X(26) for DATETIME2(6),
and PIC X(29) for all other DATETIME2 definitions.

2799778 (1096776)
• A problem that affected the use of 'select *' in OpenESQL subqueries has been fixed.

2799720 (1096751)
• A problem with array fetches into PIC N NATIONAL host variables has been fixed in the ODBC run-time

system for OpenESQL.

2799002 (1096790)
• The OCI run-time now handles the NULL indicator correctly when running in 64-bit mode.

2792566 (1096149)
• OpenESQL for JDBC now supports positioned updates with PosgreSQL.
• The THREAD SQL compiler directive option mishandled threads in certain scenarios.
• In certain scenarios, OpenESQL incorrectly handled host variables defined as SQL TYPE DBCLOB

when inserting or fetching DBCS data.
• OpenESQL for JVM now supports spaces between the start of an ODBC, JDBC, date, time or

timestamp escape marker and its associated date, time or timestamp literal string when the
SQL(DETECTDATE) directive is set.

• Use of the tinyint (pic s99 comp-5) host variable sometimes resulted in bad code generation for some
OpenESQL runtime systems. Tinyint is now fully supported on all OpenESQL runtime systems.

• The OpenESQL run-time now truncates DBCS character strings cleanly at a whole character boundary.
• Using CHARSET(EBCDIC) in a DBCS locale caused problems with the OpenESQL runtime systems for

ADO and JDBC. This has been corrected by changing the behavior to be consistent with the ODBC
runtime. In particular, SO/SI characters are now correctly inserted and removed for EBCDIC and ASCII
data respectively.

• The one-phase ODBC switch module now handles commit and rollback API calls from applications and
uses DSNRLI correctly, together with handling of global temporary tables by HCOSS applications.

XML Extensions

Back to the list

• The XML model file must be accessible to the XML extensions run-time environment. To make the file
accessible, either add it to the system path, or move it to the directory from which the program is run.

2822399 (1099702)

XML Support

Back to the list

42 | Resolved Issues



• XMLPARSE no longer reports an error if a prefix is not properly declared and no validation is specified.

2823420 (1099786)
• The Compiler no longer errors preprocessed lines containing non-ASCII characters in the indicator

area. Previously, this could cause user programs using the htmlpp preprocessor to fail to compile.

2805067 (1097977)
• The XML I/O run-time used to read the whole document into memory which caused an out-of-memory

error.

2801337 (1096999)
• The namespace prefix in the namespace declaration is now handled correctly when the element itself

does not contain a prefix.

2799691 (1098150)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.
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On Windows, you can use the Micro Focus SupportLine Support Scan Utility, mfsupportinfoII, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfoII.exe is stored in <install-dir>\bin.

To run mfsupportinfoII:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfoII at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2015. All rights reserved.
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